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Welcome to LexisNexis AU

LexisNexis is proud to announce the launch of our new global legal online platform.

LexisNexis AU offers significant enhancements to our existing LexisNexis Butterworths Online service through improved reliability and
interface functionality. It saves you time by providing quick access to all your existing Australian legal content.

LexisNexis AU has been developed specifically with the Australian end-user in mind and reflects our commitment to providing easy-to-use,
comprehensive and authoritative services to our customers through continuous improvement and innovation.

Key Features of LexisNexis AU

Quick and easy access to commonly undertaken tasks e.g.
find the full text of a piece of legislation.

Shortcuts to your favourite publications from the homepage,

increasing ease of access to frequently used sources of
information.

View a publication tree next to the related text (for some
sources).

Find the publication you need by searching or browsing all
subscribed sources by name, subject, jurisdiction or content
type.

Greater flexibility to co-ordinate your results such as viewing
the latest case searched or sorting

results by date or jurisdiction.

Enhanced printing, e-mailing and downloading functionality.

Trusted, reliable and authoritative publications
for sourcing quality content

The launch of LexisNexis AU demonstrates our commitment of
providing superior Australian and international content from trusted,
reliable and authoritative sources.

Quality Service and Support
We constantly strive to provide you with a superior level of support.
This remains unchanged.

Dedicated training is provided with your introduction to LexisNexis
AU. Our User Guide offers detailed instructions so that you get
optimal performance from LexisNexis AU.

As part of our ongoing support, our Customer Relations and
Electronic Helpline are available to assist you from Monday to
Friday, 8am-6pm (EST) and 8am-8pm respectively.
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Searching

é LexisNexis s | S | |

Home

Search Sources

Home | Cases | Legislation | commentary | Forms & Precedents | Journals | Dictionaries | services |

Introduction Common Tasks

. o . |Find a case in Casebase = | Entercasa name or citation > Latesr Cases
The Home page is divided into three > Lesishlasis nebsite
incioal it Quick Links > Training Materisls
principal parts:
Cases /Legislation Commentary,/ Other Practice Areas _
1 . Common TaSkS Base Cases and Journal Articles [] Halsbury's Laws of Australia [Browse [l civil Procedure & Litigation [Brawse] [Wiew]
[i] Unreported Judgments - All Jurisdictions [il AustEncyclopaedia of Forms % Precedents  [i| Corporations Law [Browse] [View View a Tutorial
H H Australian Current Law Reporter [Brouse __ abridoed [Browse] i] Criminal Law [Browse] [View > Oueruien
2. Quick Link 3 . 4
. UICK LINKS B, LEubog Lecielstion Alldirisd (i Ford's Princiolas of Corpurations Law B Sommceisl Lag isusel vty Zosahim
= _ [Browse S orking with Results
3 G 1S h (i) Australian Law Reporte [Brovse] [ Ritchie's Supreme Court Procedure MSW [ Intellectyal Properts Law [Brouse] [View] > Delivering Results
. eneral searc More... " [Browse More... = Scheduling Searches
|il Encyclopaedic Australian Leqal Dictienar = Selecting Sources
[Browse
More

earch

General

Search Terms

Use connectors to show relstion of terms (apple and orange, tade wy'S act, jurt finds jury, juror, etc)

Lonnectors Help

Sources & [+ All Subscribed Sources =l Gl

O cases [ Legislation il Comrmentary T Forms & Precedents

+ Show Document Sections

Clear Farm
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Common Tasks

From this section you can quickly and easily undertake common research tasks by selecting a task, entering your search terms and

clicking Go to retrieve your search results.

1. Select one of the tasks from the

. Search
drop-down list. -

2. Enter your search terms.
Common Tasks

3. Note that the help text appears to

Sources

Home | Cases | Legislation | Commentary | Forms & Precedents | Journals | Dictionaries | Services |

the right of the search box when
you select a particular task.

xt of a case
Find an Act/Regulation/Rule
Find legislation judicially considered
Find a definition of a legal term
Find a form/precedent

The tasks that are available to you
will depend upon the sources that

Find amendments to legislation

|GO —)| Entercase name of citation e

Commentary / Other

[i] Halsbury's Laws of Australia [Browse]
[i] AustEncuclopaedia of Forms & Precedents
PRaon oot

Practice Areas

[i] Civil Procedure & Litigation [Browse] [View
m Corporations Law [Browse] [View
o T T ek

you subscribe to.

How to:

/ Find a case in CaseBase
Enter a case name or citation to find the CaseBase entry for that case.

Find full text of a case
Enter a case name or citation to find the full text (reported and/
or unreported) of the case you require in your cases sources.
Examples: gould AND brown; 163 ALR 270;
1999 31 ACSR 99; 1999 HCA 27; BC9903189, S140/1998

Find an Act/Regulation/Rule
Enter a legislation title to find that Act, Regulation or Rule in
your legislation sources.

Example: trade practices; copyright

Find a definition of a legal term

Enter the term to find a legal definition in the Butterworths

Australian Encyclopaedic Legal Dictionary and/or Australian
Q_egal Words and Phrases.

Find legislation judicially considered

Enter the name of the legislation and/or a section number to
search within CaseBase and Australian Current Law Reporter to
find cases where that legislation has been judicially considered.

Example: trade practices act AND 52

~

Find a form/precedent
Enter a form or precedent title or number to find that form or
precedent within your form and precedents sources.

Example: notice AND motion

Find amendments to legislation

Enter the title of the legislation to search within Australian
Current Law - Legislation for amendments to that piece of
legislation.

Example: Corporations Act 2001

/
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Quick Links

Use the Quick Links section to search or browse a source to which you subscribe. The sources are categorised by different content types.
Cases and legislation sources are listed in the first column and commentary and other (eg journals, forms & precedents etc) sources in the
second column. In the third column you will find practice areas (similar to the libraries links on LexisNexis Butterworths online).

1.

2
3.
4

6

Click on the source title to search that source.

Click on the word Browse (where available) to view the Table of Contents of that source.
Click on the word [View] next to the practice areas to see the list of sources.
To view further sources or practice areas click on the More... links.

Quick Links

Cases /Legislation

S

CaszeBasze Cases and Journal Articles
Unreported Jud - All Jurisdiction

Australian Current Law Reporter [Browse]

E=

Australian Law Reports [Browse]

More...

LawMow Legislation - All Jurizdictions

Commentary / Other

[i] Halsbury's Laws of Australia [Browse]

[i] AustEncyclopaedia of Forms & Precedents
Abridged [Browse

(3] Ford's Principles of Corporations Law
Browse

(3] Ritchie's Supreme Court Procedure MSW
Browse

[i] Encyclopaedic Australian Legal Dictionary
Browse

More...

Practice Areas

[i] civil Procedure & Litigation [Browse] [View
m Corporations Law [Browse] [Wiew

[i] Criminsl Law [Browse] [View]

rﬂ Commercial Law [Browze] [View

[i] Intellectual Property Law [Browse] [View

More...
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General Search

Use Generall

Type your query in the Search Terms box. Use connectors to
show relationship of terms eg AND, OR, w/5 (see page 15 for an
explanation of available terms and connectors)

Select the sources you wish to search across. You can choose
sources from the drop-down list, or tick the box beside a
particular content type.

| General Search

Search Terms

=l Save This Search

Use cannectors to show relation of terms (apple and arange, trade 'S act, jurt finds jury, juror, etc)

)

C [T cases [T Legislation [T Commentary T Forms & Precedents

Connectors Help
e @ [ Halsbury's Laws of Australia

More Sources | Edit Recent Sources

Sources

More Options

My StartPage | B

3. To learn more about the contents of a source, click the
information icon [i! next to the sources
drop-down list.

+ Show Document Sections

Clear Farm

4. Click Search to run the query.

5. You can also choose to find your search term/s in specified parts
of a document by using the Show Document Sections option.

- Hide Document Sections e

Select the section restriction required, enter terms and click "Add to search”.

” *| search within: |- Select a Section - =

6. Select a connector from the first drop-down list (no connector,
Using terms; Add to search

AND, or OR).

7. Select a document section from the Search Within drop-down
list. Only the sections available in the source you selected are
shown (if you selected a combined source, all the sections
available in any of the individual sources are shown).

Clear Farm

8. Enter search terms that are appropriate for the section you selected in the Using terms text box.

9. Click the Add to search button to add your document section search criteria to the Search Terms field. The syntax of your document
section search will automatically be formulated correctly eg JUDGE (Dixon)

Note: Document sections are specific, pre-defined segments of a document through which you may target your search. For example, you
may search for specific words only within the legislation title section, or a specific name only within the judge section. You may construct a
search entirely out of document sections, or combine a document section search with your other search terms.
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LexisNexis AU offers several ways for you to search, using the
content-type tabs that appear across the top of all search pages.

The Content Specific Search pages that are available are:
1.

8

Cases - use this form to search all of your cases sources.
Depending on your subscription, this may include Australian
Law Reports, Family Law Reports, Unreported Judgments,
Australian Current Law Reporter and CaseBase Cases.
From this form you can also access the CaseBase search
form (to search both the cases and journals components of
CaseBase), as well as the Australian Current Law - Reporter,
Australian and New Zealand Citator to UK Reports, Cases
Indexes/Tables search forms.

Legislation - use this form to search your subscribed
legislation sources. Depending upon your subscription, this
may include sources such as LawNow Legislation, Australian
Corporation Law - Legislation, Federal Statutes Annotations
plus the legislation content of sources that contain more than
one content type (ie commentary , legislation and forms etc)
such as Bankruptcy Law and Practice. From this form you
can also access source specific forms for Australian Current
Law - Legislation, Statutes Annotations and Legislation
Indexes/Tables (eg LawNow Progress of Bills information).

Commentary - use this form to search within commentary
sources, or within the commentary portions of services.
Depending on your subscription, this may include sources
such as Halsbury’s Laws of Australia, Cross on Evidence, and
Ford’s Principles of Corporations Law.

LEXISNEXIS AU — USER GUIDE

Journals - use this form to search within your journals
sources. Depending upon your subscription, this may include
sources such as the Australian Journal of Contract Law,
Insurance Law Journal and the Australian Bar Review.

Forms and Precedents - use this form to search within

your subscribed forms and precedents sources. Depending
on your subscription, this may include the Australian
Encyclopaedia of Forms and Precedents, Australian

Tenancy Practice and Precedents and Federal Civil Litigation
Precedents. You may also use this form to search forms and
precedents that appear in other sources, such as practice and
procedure works and services.

Dictionaries - use this form to search within your subscribed
dictionaries sources. Depending upon your subscription, this
will include the Butterworths Encyclopaedic Australian Legal
Dictionary and Australian Legal Words & Phrases. From this
form you can also access Australian Dictionary Tables search
form.

Services - use this form to search within your subscribed
services sources. These are sources that contain more than
one content type, ie they may contain two or more of the
following content types: commentary, legislation, forms &
precedents, cases. Depending upon your subscription, this
may include sources such as Practice and Procedure - High
Court - Federal Court, Federal Criminal Law, Bankruptcy Law
and Practice and Immigration Law.



Each search page has similarities, but each section is designed to 5.

search a particular type of content

For example: when using the Services page, you have the
following options for searching:

1. Search Terms

Enter your search terms, using connectors to show the
relationship between the terms. See Terms and Connectors
(page 17) for more information.

2. Note: you can also click Connectors Help to find information
on entering search terms and connectors.

3. Sources

Select a source from your most recently used or favourite
sources, or click More Sources to go to the Sources tab to
select from all available sources within this search form.

To learn more about the contents of a source, click the
information icon [i! to the right of the source menu. This
will explain the available document sections, currency
information, coverage/span and source overview etc.

4. Search Within

Select the type of content that you wish to search across
within your selected source/s. The choices will depend on the
content type you are searching. You may choose to search
across all the material in the source or choose a subset that
may include Legislation, Commentary or Forms/Precedents.

Search
To begin your search, click the Search button.

Content specific search options

These search options are designed to find references within a
particular content type. For example, the Cases search page
will offer the option to search for words appearing in the case
name or the Catchwords, while a Commentary search allows
you to search for words in Commentary headings or where
cases or legislation are referred to.

Example:

Headings - find words that appear in headings only.
Sec/Reg/Rule - find a particular section, rule or regulation.
References to Cases/Legislation - find references in the
commentary.

Form Number/Form Title - find a form or precedent by
number or title.

Searching a source’s index or table

Click on the Service Index/Tables link in the top right hand corner
to be taken to the Index/Tables search form.
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8.

10

Search within particular
document sections

Click on Show Document
Sections to reveal this section of
the search form.

The document sections that
appear in the Select a Section
drop-down list will be customised
to search the content type you
have selected.

LEXISNEXIS AU — USER GUIDE

@ LexisNexis-

Home > Serices
Search

Home | Cases | L

Search Terms

Sources

Search Within
Legislation Title
Part/Order

SecfRegfRule

Form Number
Form Title

References to Legislation

References to Cases

Sources

on | Commentary | Forms & Precedents | Journals |

Customiss | Sian Out | Contact Us | [FlHalp

Use connectors to show relation of terms (apple and orange, trade wS act, jurt finds jury, jurer, etc)
ecnnnectm's Help

|+ All Subscribed Services Sources

Elal 3 )

+ Show Document Sections

[ Al Material in Selscted Source
I
I
I

e.g. for section 52 entert 52

BacktoTop | Clear Form

* Serwice Indexes/Tables

= Internatignal Services

Related Searches

= Bulletins Search

> Legizlstion Search

> Commentary Search

> Forms And Precedents
Search

How do 1...2

= Search a particular
auidecardichapter?

> Find 2 section of
legislation?

> Search for ASIC
releases?

> Zearch for codes of
practice and ather quasi-
legislative instruments?

View a Tutorial

= Ouerview

> Searching

= Working with Results

= Delivering Results

> Scheduling Searches

> Selacting Sources

6 - Hide Document Sections

Select the section restriction required, enter terms and click "Add to search”,

I 'I Search within: I- Select a Section - 'I
Using terms: I Add to search

Clear Form




Sources tab

The Sourcl]
find the source you wish to access, either through viewing lists of sources or by searching for a specific source.

To Access the Sources tab

1. Click the Sources tab from any page.
Or
2. To reveal more sources from within a Search form, click the More Sources link next to the source selector.

@' LexisNexis-

Horne > Cases

Search Alerts Sources 0

Home | Cases | Legislation | Commentary | Forms & Precedents | Journals | Dictionaries | Services |

Sources |_+ &ll Subscribed Cases Sources __v_I il

More Sources | Edit Sources
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There are two ways to use the Sources tab: click the Browse tab and explore the Sources tab or click the Find Sources tab and enter a
word or words to find sources with those words in the title.

You can view your sources in the directory either alphabetically by name, by jurisdiction, by content type or by subject.

1.

To

12

Select the relevant option from the
drop-down list at the top of the page.

Large category folders =
indicate a group of sources. Click
the title of the folder to browse
those sources. Sources are
indicated by a document icon B.

Click any information icon (i
beside a source title to learn more
about the source.

explore sources:

Click the category name for your
area of interest to the right of the
folder icon 0 to navigate further
down into the category.

When you have identified a

source in which you want to
search, click the source name,

indicated with a document icon e@@

, to go to a search form.

Click the Browse link to the right
of a source to navigate into the
Table of Contents.

| LEXISNEXIS AU — USER GUIDE

Home > Sourcas

| Search | Alerts @

[ rouse Sources \Find Saurces

¥iewby |Subject R
CDntEntT pe

Combine Sources

Trail:

=] Indigenous Law

3 Insurance Law

3 [ntellectual Property Law

I35 17 & Telacommunications Law
=] Licensing Law

3 Local Governmant

I3 personal Injury

=] Planning Law

13 profiassions

=) Property Law

3 administrative Law Law

Banklng,& Finance Law
5 pankrupley & Insolvency Law

\‘ Search ‘|' Alirts W

Wiew by |Subject

Trail:  Subject Hdme > Administrative Law

Administrative Law Decisions [Browse] B LawMow NSW Legislation [Browse]
B al England Law Reports [Browse] B LawMow NSW Legislation Histarical Yersions [Browse]
B[ australian Current Law Legislation [Browse] B LawMow Queensland Bills Information [Browse]
B i Australian Current Law Reporter [Browse] Bl LawNow Queensland Legislation [Browse]
B Australarrent Law Tables [Browse B0 LawNow Queensland Legislation Historical Yersions [Browse]
B sustral dministrative Law [Browse] B LawMow Victorian Bills Information [Browse]




Use the Find Sources tab when you know the specific source that you want to search or browse.

1. Type the name of the source, or words contained in the name of the source, in the text box next to Source Name eg Halsburys

2. Click Find Sources.

Note: You cannot use Boolean connectors (AND, OR, NOT) or universal characters (!, *) when entering a source in the Find Sources field.

Home > Sources

Search | § Sources

| Browse Sources | Find Sources

Source Name || # Find Sources

Examples: "Halsbury's Laws of Australia® or Halshury Austealia
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Use this feature to allow you to search across two or more sources at one time eg you may wish to combine Australian Corporations Law
Principles and Practice and Ford’s Principles of Corporations Law.

1.  While on the Sources tab, click the Combine
Sources “maximise” icon [2 in the right hand
side of the screen.

2. Inthe main Sources screen, click any Add link
next to a publication or source to add that to
your Combined Sources list.

3. Choose a name for your combined source.

4. Click Done when you are finished selecting
sources. Your combined source will appear in
the Search form’s source list.

Note: Your combined source will not appear as an
item in the Sources tab. It will appear in the source
menu on your current search page only.

You can minimise this form at any time by clicking
the minimise icon [=]. Any contents in the
Combined Sources list will be lost if you close the
form without clicking Done.

Note: Some sources might not be able to be
combined at all. If there is no Add link next to a
source, you cannot combine it with others.

14 | LEXISNEXIS AU — USER GUIDE

| Search | Alerts

Combine Sources

Forouse Sources UFind sources
viewby [Subject -

Trail:  Subject Home > Garporations Law

@ LexisNexis:

Horme > Saurces

Customise | ign ©ut | Zontact Us | [FlHe

| Search “EELTTEER

Combine Sources

[orowse sources \Find sources
viewby |Subject -

Trail: Subject Home > Carporations Law

Select a source or group of
sources by adding them to the
box below. Click the Done

button when you are finished.

Click the "Add" link to include a source in the Combined Sources tray. 40 Trems Magimum

B al England European Cases [Browse] Add » B Halsbury's Laws of Australia [Browse] add »
B 4l England Law Reports [Browse] Add > B Halsbury's Laws of Australia Index & Tables

B0 asIC Releases Index [Browse] Add = _ IBrowsel Add =
B australian Current Law Legislation [Browse] Add B Halsbury's Laws of England [Browse] Add >
2 B LawNow Cth Bills Information [Browse] Add =
B australian Current Law Reporter [Browse] add > B Gl LawNow Cth Legislation [Browse] Add =
B Australian Current Law Tables [Browse]l Add > B LawNow NSW Bills Information [Browse] Add =

Remove Selected Source

Name for Current Source(s)

B aust Corporation Law ASIC Releases [Browse] B[] LawNow NSW Legislation [Browse] add =
one
_ Add> B LawNow NSW Legislation Historical Yersions o
B Aust Corporation Law Legislation [Browse] Add > Browse] Add =

Note: Game sources cannot be

B[ aust Corporation Law Principles & Practice B Lawhow Queensland Bills Information [Browse] combined, Sources that cannot be
[Browse] Add > i combined do not haus "Add" links
B australian Corporations & Securities Reports (& B[] LawNow victorian Bills Information [Browse] Add
ACLR) [Browse] Add = =
B0 sustralian Carporations & Securities Reports B LawNow victorian Legislation [Browse] Add >
Index [Browse] Add > B Lawnow victarian Legislation Historical Yersions

B australian Corporation Practice [Browse] Add = Browse] Add =
B australian Corporation Practice Bulletin [Browse]l B Laws of New Zealand [Browse] Add >

_ Add> B LawNow Quesnsland Historical Acts [Browse
B[ australian Corporation Practice Index [Browse] Add > =l




Terms & Connectors

Words
Words are the basic units of a search. Aword is a single character or group of characters, alphabetic or numeric, with a space on either side.
Examples:
McPherson one searchable word
s198 one searchable word
s 198 two searchable words

A hyphen is treated as a space, so a hyphenated word is seen as two words.

Examples:
email one word
e-mail two words
e mail two words
Phrases
Consecutive words are assumed as a phrase. You must use a connector to separate words that you wish to find in the same part of a document.
Examples:
contributory negligence finds the phrase “contributory negligence”

contributory AND negligence finds separate occurrences of the words “contributory” and “negligence”

Plurals
Using the singular word form will retrieve the singular, plural, and possessive forms of most words.

Example:
city would find city, cities, city’s, and cities’
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The system will not automatically find the plural form of words that end in “us” or “is”, or other irregular plural forms.

Examples:
bonus would not find bonuses
child would not find children

Note: Use the OR connector in these instances, for example child OR children, or use a wildcard.

Connectors
The AND connector finds your search terms within the same document.
Example:
assault AND robbery finds the words “assault” and “robbery”
armed robbery AND weapon finds the phrase “armed robbery” and the word “weapon”

Use the OR connector to find documents that contain either or both of the words or phrases linked by OR.

Example:
lawyer OR counsel finds the words “lawyer” or the word “counsel,” or both
takeover OR take over finds the words “takeover” or the phrase “take over,” or both

Use the W/N connector to find documents with search words that appear within “n” words of each other. The value of
number up to 255. Either word may appear first.

“n

n” can be any

Example:
fraud W/3 taxation finds “fraud” within three words of “taxation”
airport W/5 noise W/5 abat! finds “airport” within five words of “noise” and then some form of the word “abate” within five words of

either “airport” or “noise”

Use the W/P connector to find documents with search words that appear within the same paragraph.

Example:

rule 11 WI/P sanction finds “rule 11” within the same paragraph as “sanction”

take over OR

takeover W/P hostile finds “take over” or “takeover” within the same paragraph as “hostile”
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Use the PRE/N connector to find documents in which the first search word precedes the second by no more than the stated number of words.

Example:
pay PRE/3 television finds documents in which “pay” precedes “television” by three or fewer words

Use the AND NOT connector to find documents in which a search word or phrase is to be excluded.

Example:
trust AND NOT charitable finds documents where the word “trust” occurs but the word “charitable” does not

Use the NOT W/N connector to find documents in which the first search word is found and where the second word need not be in the

document, but if it is, it cannot be within ‘n’ words of the first word.

Example:
assault NOT W/2 sexual finds “assault” but not if it occurs within two words of “sexual”, excluding references to sexual assault.

Connector Order and Priority

Connectors operate in the following order of priority:

« OR

*  WIN, PRE/N, NOT W/N
- WIP

e AND

* AND NOT

If you use two or more of the same connector, they operate left to right. If the “n” (number) connectors have different numbers, the smallest
number is operated first. You cannot use the W/P connector with a proximity connector (e.g. W/N).

Changing Connector Priority

To change the connector priority, use parentheses. Connectors inside parentheses have priority over, or operate before, connectors outside
parentheses.

Example:
bankrupt! W/25 discharg! AND (student OR college OR education W/5 loan)
Prioritises as: (student OR college OR education W/5 loan) AND (bankrupt! W/25 discharg!)
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Precision Search Commands

In addition to connectors, there are several commands you can use to add precision to your searching.

Capitalisation Pluralisation

To specify that all search words have capital letters (ALLCAPS), no There may be times when you want only the plural or singular form

capital letters (NOCAPS), or one or more capital letters (CAPS), of a word.

type the command followed by your search words enclosed in Example:

arentheses. ’

P To find documents that mention service of a summons
Example: _ o ENTER: serv! w/3 plural (summons)
Tof§garch for documents tgat mention acquired immune To limit your search to the singular form and to search for an
deficiency synfjrom.e (AIDS) . additional item such as job discrimination
ENTER: acquired immun! OR allcaps (aids) ENTER: singular (job) w/5 discriminat!
To search for mentions of an aid:
ENTER: nocaps (aid) At Least
To search for Ald.as a title with the first letter capitalised: To locate documents that contain an in-depth discussion on a topic
ENTER: caps (aid) rather than just a mention, you can specify that a word or certain

words must appear at least so many times in a document.

Example:

To find documents that contain an in-depth discussion of GST,
the Goods and Services Tax

ENTER: atleast10 (gst)

This search requires GST to appear in every document at
least 10 times.

Note: You can use any number from 1 to 255 with the AT LEAST
command.
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Date Restrictions

For sources that include date information (eg cases, journal
articles), you have a number of options to restrict your search
results to specific time periods.

Predefined date ranges can be selected from the drop-down list
(eg Today, Previous Week, Previous Month, Previous Year etc).
You may also use the second drop-down list to specify more exact
dates or date ranges. For example:

Previous Select up to a hundred previous days, weeks, months or years

From Select a specific date range, eg From 1 Jan 2003 to 30 June 2003

Is Select an exact date, eg Jul 24 2003

Before eg Before 31 Dec 2002

After Use this option to specify that your results should be after a specific date,
eg After Jan 2003

LEXISNEXIS AU — USER GUIDE | 19




Truncation (!) and
wildcard (*) searches

The truncation (!) replaces any number of characters at the end of the word.

The truncation (!)

Example:
neglig! finds “negligent,” “negligence” and “negligible”.

Note: Words that work best with ! are those that are unique in their truncated form. For example, if you search for fir! (thinking that you wanted to
find “fired,” “firing,” or “fires”), your results will also include “first,” “firm,” and so on.

The wildcard (*)
The wildcard (*) replaces a single character at any point in a word.

Example:
maximi*e finds both “maximise” and “maximize”.

The wildcard (*) is particularly useful if you are unsure of the spelling of a particular word or name. You can also use multiple wildcards in a
single word.

Example:
sm*th finds both the “smith” and “smyth” spellings of the name.
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You can look at your search results
in several different view formats,
available through the View

drop-down list on the Results form.

Home > Cases - [l Subseribed Cases...][i] > good faith and insurance(26139)

‘Result Groups

Select to view:

- Select Group - =l 0 wiew: [Expanded List =] sort:[Reverse Chronological -]

[ i

(=

Court Abbre 5 Judagrnent Date

CRESTLIME PTY LTD v GRAHAM - BCZN0405352 WASC 20/08/2004

o Trade Practices Act 1974 5 52 CSR Ld v Cigna Insurance Australia Lrd (1997) 189 CLR 345 Jackson v Sterling Industries .
.« SA[1934] 1 WLR 58% ; CSR Ltd v Mew Zealand Insurance Co Ltd (1994) 36 NSWLR 138 ; Fink v Fink (1946) ..
. of $10,000 for breaches of the | and gaod faith abligation= under the Act, and an amountforaccrued annual ..

.« braach of the employment agreament ar for breach of the goad faith ebligation an employer awes an employes under the Act, comper\sation

... to questions in the Authority proceedings as to the plaintiff's good faith and whether the defendant's dismis=sal was fair, It is also .
.« considered by the High Courtin CSR Ltd v Clana Insurance Australia Ld (1997) 185 CLR 345 . In that case, an
v of the court's inherent or equitable jurisdiction, [22] In Cigna Insurance, the majority in the High Court cor\sldered that the fact.,

CATTO (as executor of the estate of CATTO) v HAMPTORN SASC 19/08/2004
AUSTRALLA LTD (in ligh (No 3% - BC200405234

. The plaintiffs claimed that the allotments were not made in good faith, nor in the best interests of the companies and were |

"be added the tangible benefits o ths asssts controlled by Insurance also being brought within the corporate umbrella of Holdings, by virtus of Insurance being & wholly ouned

Subsidiary, [63] T think these paints ..
1 to act with care and diligence andto act in good faith and for preper purpeses, [113] Division 4 of Pt 5.5 ..,
... againzt the liquidstor da not raize allegations of lack of gaod faith ar even lack of independance, Mr Angys| srqued that becsuse ..

... during an interchange with me, an hypothetical liquidatar, acting in qood faith and entirvely indepandently of any pressure, could reasonably have arrived ..
v Hampton and advising them to ensure that they held adequate insurance to cover their actions as directors, Those letters were closely ..

Narrow Search | £ search

[0 [ 1-500f 2618 Results [»] [#]

Unreported Judgments Western Australiz

Unreported Judgments South Australia

List View

» Displays basic information about the documents your » Displays the same information as in List View for each
document, plus your search terms in context, surrounded

search retrieved in a numbered list.

* Click the Document Title to view the full text of the
document. Check the box next to the title to tag the
document for viewing or delivery.

*  Court and Judgment Date will be included in search

results from Cases sources.

Expanded List View

by up to 10 words on either side.

List with Catchwords view
(for Cases sources only)
» Displays the same information as the L

~

ist View for each

document plus the catchwords of the case (where available).
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To change the order of the displayed documents, select a sort format from the Sort drop-down list on the Results page. Sort

options vary according to the type of documents in your results, but may include Reverse Chronological (ie most recent case first),
Jurisdiction/Court, Relevance and Source Order among others.

Search within your results by adding terms and/or connectors to the Narrow Search box and click on Search.

Horme > Cases - [All Subseribed Cazes...][i] > good faith and insurance(2619)

sult Groups o] Results | ‘Saue This

Select to view:

[“Select Group - -1 View: IExpanded List =] sort: [Reverse Chronological =] 0 [ [ 1-500f 2619 Results [3] [

iatinns Judament Date

Ot CRESTLIME PTY LTD v GRAHAM - BC200405352

20/08/2004 Unreported Judgments Western Australia

o Trade Practices Act 1974 £ 52 CSR Ltd v Cigna Insurance Australia Ltd (1997) 189 CLR 345 ; Jackson v Sterling Industries ..

.. A [1994] 1 WLR 588 CSR Lrd v Mew Zealand Insursnce Go Lrd (1994) 36 MEWLR 138 Fink u Fink (19d6) ...

.. of $10,000 for breaches of the employment agreement and good faith ebligations under the Act, and an amount for accrued annual ...

« breach of the employment agreement or for breach of the qood faith obligation an emplover owes an employes under the Act, compensatmn
o T questions in the Autharity procesdings a5 to the plaintiffs qood faich and whether the defandant's dismissal was fair Iris also

.+ cansidarad by the High Courtin C3R Ltd v Cigna Insurance Australia Ltd (1337) 183 CLR 345 . In that case, a

o of the court's inherent or equitable jurizdiction, [22] In Cigna Inzurance, the majority in the High Court cans\dered that the fact .,

[ e CATTO {as executor of the estate of CATTO) v HAMPTON SASC 19/08/2004 Unreported Judgments South Australia
AUSTRALIA LTD (in lig) (Mo 3} - BC200405234

«. The plaintiffs claimed that the allatments were not made in good faith, norin the best interests of the companies and were .

' be added the tangible beneflts of the assets controlled by Insurance also being brought within the corparate umbrella of Holdings, by ¥irtue of Insurance being a wholly owned
subsidiary, [68] I think these points ..

ot et with care and diligence and ta scr in anod fith and for proper purposes, [113] Division 4 of Pr 5.5 ..

\ againzt the liquidator do net raise allegations of lack of good faith or even lack of independence, Mr Anayal argued that because

... during an intarchangs with me, an hypothetical liquidstor, 3cting in good faith and sntirely indepandsntly of any pressure, could reasanably have arrived ..
. Hampton and aduising them to snsure that they held adequate insurance to cover their sctions a5 directors, Those letters were closely .
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Use the Result Groups form to display a
specific category of documents within your
search results. For example, you may want
to view the list of results from a specific
source or from a particular jurisdiction/court.
The available result groups vary depending
on the content of your search results.

Note: The Result Groups form is available
when viewing your results in the List,
Expanded List, or Expanded List with
Catchwords views only.

1. Ensure that the Result Groups form is
maximised [3] .

2. Click on the drop-down list to select how
you would like your results grouped.
Depending upon the sources you have
searched, the groups may include
source, court and legislation title.

3. Click a category name to view that
list of results in the results page (right
frame). The display includes the number
of documents in each category. Each
category or sub-category provides a
filtered view of the original results list so

that only those results within that category

or sub-category are displayed in the
results page.

4. Click the All Results link at the top of
the Result Group display to return to the
original results list.

Result Groups

B =

sults

1 view Toased =] o I )

| BaveTh

Narrow Search |2 Search|

view: [Expanded List

em

=] sort: [Reverss Chranological =] [0 [ 1-100F2619 Results [2] [21]

Judgment Dat

ETECT 5 VIS IO TS [T 1  CRESTUINE PTY LTD v GRAHAM - BC200405352 WASC 20/08/2004 Unreported Judaments Western
above dropdown to see Australia
categorised results. -
. Trade Practices Act 1974 5 52 CSR Led v Clgns Insursnce Australis Ltd (1997) 189 CLR 345 ; Jackson v Sterling Industriss ..
. 5A [1994] 1 WLR 588 CSP Ltd u New Zealand Insurance Co Led (1994) 36 NSWLR 138 5 Fink v Fink (1946) ..
-+ §LO.000 for breaches of ths smpl and 2004 faith sbligstions under ths ACt, and an smount for accrusd snnusl .
. braach ofthe emplagment agraemant orfor breach of the uod faith abligation an employer awes an employee under the Act,
tumpensatmn
. to questions in the Autharity proceedings as to the plaintiff's good faith and whether the defendant's dismissal was fair. Tt is also .
.. considered hy the High Courtin CSR Ltd v Cigna Insurance Australia Ltd (1997) 189 CLR 345 . In that case, an ..
- ofthe court's inherent or squitable jurisdiction. [22] In Gigna Insurance, the majarity in the High Court considared that the fact .
0 == CATTO (as executor of the estate of CATTO) v SASC 19/08/2004 Unreported Judgments South
HAMFTON AUSTRALIA LTD {in lia) (Ho 3) - Eriay
BC200405234
Home > Cases - [All Subscribed Cases...][1] > goad faith and insurance(2615)

Result Groups [~}
Widen >

Source -

All Results (2619)

Administrative Law Decisions (7022
Australisn Capitsl Territory - Unre
Australian Capital Territory Repari
Australisn Consumer Credit Repor
Australisn Corporation and Securit
Australian Law Reports (247)
Butterworths Property Reports (12
CaseBase Cases (440)

Eamily Law Reports (20)

Federal Court of Australia - Unrep:

Results

iew Tagaed| |[=] &4 £=1
¥iew: |Expanded List -

| |

0=

Narrow Search [#£/Bearch]

[ [0 1- 10 0f 247 Results [2] [31]

Selected Group: Australian Law Reports (Yiew all Results) I—|

Judgrent Date

COLE v SOUTH TWEED HEADS RUGHEY LEAGUE
FOOTBALL CLUB LTD and Another - 207 ALR 52

15/06/2004 Auztralisn Law Reports

.. for the rejection ofthe offers, they were made in 2ood faith and if they had besn accepted itis unlikely that, ..
< direct liability to the injured, with  resulting increase in insurance pramiums that might stimulste a desirable change of culture and ..

ALEXANDER and Others {t/as Minter Ellison) v 12/02/2004
PERPETUAL TRUSTEES WA LTD and Another - 204
ALR 417

HCA Australian Law Reports

. 4) Subject to section Z4(2B), 2 person who in good faith has made or agreed to make any payment in sertlement .,
Maher (1959) 103 GLR 478 4t 484-5 ; State Govarnment Insurance Offica (QId) v Crivianden (196€) 117 CLR 412 st 416
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Viewing Specific Sections of a Publication

1.

24

In Document View, you can use
the Publication Tree to display
a document’s location within a
source. For example, if you are
viewing a particular section of

a statute, the Publication Tree
displays the table of contents

for the entire statute, showing
the names of the sections

before and after the one you are
viewing. Items displayed on the
Publication Tree form are linked
S0 you can quickly view other
sections of the publication.

In addition to using the
Publication tree to navigate
through your source you can click
on the Next document icons

LEXISNEXIS AU — USER GUIDE

Horne > Commmantary - [Halsbury's Laws... ][0 > mislaadi

and d and ©..(177) > Docurnent(177)

Publication Tree L
Table of Contents = 0

@ Browse | Widen

[B [15-2551, Responsil
[B) [15-280]. Acts beuc
[B) [15-285], Contracts
[B)[15-270] Exscution
[3) [15-275]. Euclusion
[B) [15-2801, Settlemer
[2) [15-285]. Fraud and
B [15-220], Admissis
[B[15-295] Motice to
[2) [15-300]. Bribery of
[B [15-305]. Dispesitic
[B) [15-310]. Dispesitic

[~ B [E) (5) RELATIONS BETWE

[~ BB (5) TERMINATION

@ 20 = Animals

M E 25 = Arbitration (3)

M E 20 — Auction (1)

M @40 = Bailment
[T E 45 — Banking and Finance (4)
M E50 — Bankruptey

[T BB reLaTions BETwela| [ 1. (7) RELATIONS BETWEEN PRINCIPAL AND T...

[2] Previous/Next Dacument [*]

& (= B [ search source

@ @1ora77E &
[0 @ Hirs: =

1 of 12 [ [3)
and is extending credit only to the agent,2 or unless the third person’s conduct leads the principal e
reasonably to believe that the debt has been paid by the agent® or that the third person has elected? to
look to the agent alone for payment,2 and in consequence the principal’s position is altered as regards
the agent to the principal’s prejudice.® Mere delay on the part of the creditor is not, of itself, sufficient
to discharge the principal £

In respect of payments by the third party, the third party is not discharged from the liability to the
principal by any payment to, or settlement with, the agent,® unless the paym\?nt or settlement is ratified
by the principal or is made in the ordinary course of business, or in accordance with the agent’s authority
(whether express, implied or apparent).? If, however, the principal has allowed the agent to appear as
principal in the transaction in respect of which the payment or settlement is made, the third person is
discharged by any payment to or settlement with the agent which would have discharged that person if
the agent had been in fact the principal 22 The third party is also entitled to set offll any dehts due
from the agent personally, provided that the payment or settlement was made or the debt incurred
befare the third party knew of the existence of the principal 12

wwhere, however, an agent sells in his or her own name goods belonging to the principal over which the
agent has a lien against the principal, the purchaser is discharged to the extent of the value of the
agent’s lien by any payment to or settlement with, or set-off against the agent,12 even though the
purchaser knew of the existence of the principal at the time of the contract,2 or has had a demand for
payment from the principal 2%

[1] Previous/Mext Document @

& E |TJ Search Source

| Resules |

E EyorrrrE




3. If a document is available in PDF format (eg cases in Australian Law Reports, legislation in LawNow), the PDF link is available next to
the document title.

Publication Tree i B W ssveSeavch | MewSearch i
[£] Previous/Nent Document. [*] Related Content [Select Related Content 2]
& T2 (B (7 serch source [ (& zore (3] (il
[T 2. WAKIM v HIH CASUALTY & GENERAL INSURA... e [0 @ Hiessw 1 of & [z (1
WAKIM v HIH CASUALTY & GENERAL INSURANCE LTD (NG981 of 1993) - (2001) 182 e
ALR 353
Navigating Through Your Results Moving though Hits Within a Document
4. Use the following navigation buttons to move quickly through 5. In Document View, the number of search terms (“hits”) in the
your results list, or through a set of documents in Document document is displayed on the upper right of each document.
View. They appear on the right side of the Results or Click the Hits navigation buttons to move quickly from search
Document form. term to search term in the document:
They do not appear if your search retrieves only one [ Click to view the first search term in the document.
document or one page of results. Click to view the previous search term in the document.
I Click to view the first page or document of your resullts. Click to view the next search term in the document.
Click to view the previous page or document of your ! Click to view the last search term in the document.
re?ults. ) Note: If the Publication Tree is closed, click the maximise icon
Click to view the next page or document of your results. [El to open it. The Table of Contents for the source containing the
=l Click to view the last page or document of your results. document you are viewing appears, with the document highlighted.

Note: Numbers representing the number of pages in your results
list appear at the bottom of each page of results. The numbers are
links that you can use to move to a specific results list page.
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You can select(’
documents 1, 6 and 10 in your results, you can later print just those tagged documents.

1. To tag a document, check the box next to the document’s title.

2. To tag all documents on a particular page of a results list, check the box on the far left of the red bar above the results.
3. To print, email, or download tagged documents, click the appropriate delivery icon on the Results or Document form.
On the delivery form that appears, you'll see the document numbers you tagged displayed in the Selected Items box under Document Range.

4. To view only tagged documents in List, Expanded List or List with Catchwords view, tag your documents, select the view, and click
the View Tagged button.

5. To view only tagged documents in Document View, tag your documents and click the View icon =

Home = griffiths(483)

Result Groups

Select o view: [ vimn Togged) 5] & = Narrow Search [ 5earch]
- Select Group -5 ¥iew: [Expanded List =] sort: [Reverse Chronalogical =] 0 [ 1- 10 of 493 Results [3] [3]

Judgrrisnt Date e =

¥ 1 United States of America v Griffiths — [2004] FCA 895
BC200404283

TITZ004 CaseBase Cases

United States of America v Griffiiths [2004] FCA 895 ; BC200404283 FCA Jacobson 1 7/7/2004
« considered by this caze Related United States of America v Griffiths 7/7/2004 FCA [2004] FCA 879 ; BC200404207 Applied Cabal ..,

= 2 Griffith v ABC — [2004] NSWSC 582; BC200404130 MEWSC 5{7/2004 CaseBase Cases

Grifiith v ABC [2004] HSWSC 5682 ; BC200404130 NSWSS Cripps A1 5/ ..

¥ 3 Minister for Lands, Planning and Environment v Griffiths — [2004]  NTGCA 10/5/2004 CaseBaze Cases
NTCA 5; BC200402531

Winister for Lands, Planning and Environment v Griffiths [2004] NTCA 55 BG200402531 NTCA Martin (BR) €1, Mildren and .., —
. See Case Mote; Minister for Lands, Planning and Environment v Griffiths - - (2004) 6(%) MTM 167 Gases considered by this case .,

| R v Griffith — [2004] QCA 110; BCZ00401689 QA 16/4/2004 CaseBase Cases

R v Griffith [2004] QCA 110; BC200401889 QCA Davies , McPherson and Williams 1A ..

26 | LEXISNEXIS AU — USER GUIDE



There are three ways you can access the Table of Contents of a source.
1.

From Quick Links
Click the word Browse beside a source title.

From Sources

Click the Sources tab. Navigate the Sources tab (see page 12)
to your desired source, and click on the Browse link beside the
source title.

From a Content Specific Search Page

Click on the Browse tab at the top of the page. From the list of
subscribed sources of that content type, click on the name of the
source you want to browse.

Note: from the Table of Contents you can also access the Index and
Bulletins of a source (where available)

Browsing

Cases /Legislation
[[] caseBase Cases
[i] Australian Law Reports [Browse]

[i] LawMow CthLegislation [Erowse
[i] LawMow MSW Leqislation [Browse]

Commentary /Other

[l Halsbury's Laws of Australia [Browse]
AustEncyclopaedia of Forms & Precedents
Browse
¥ Ritchie's Supreme Court Procedurs M5

Browse

viewby [Content Type =

Trail: Content Tps Home > Commentary

pmE
Browse] Add >

BE
BE

add >

Add >

i| Unreported judgments - all - 3 ;s o
El [i] Encyclopsedic Australian Leqal Dictionary
More... [Browse]
More...
Home > Sources
| search | alerts
|l Browse Sources \ Find Sources

Click the "Add" link to include a source in the Combined Saurces tray.

Aust Corporations Law Principles & Practice

B australian Corporation Practice [Browse] Add > Add =
B australian Criminal Trial Directions [Browse] add BT Land & Environment Notes [Browse] Add =
= B Ritchie's Supreme Court Procedure NSW

The College of Law Practice Papers [Browse

Ford's Principles of Corporations Law [Browse

BmE
=]

Halsbury's Laws of Australia [Browse] Add >
kelly & Ball Principles of Insurance Law [Brawse]

Browse] Add =

Home * Commentary

Alerts \{ Sources

Search

Home | Cases |Legislation | commentary

Search | Browse & W TGTIIG 1Y

| Forms & Precedents | Journals | Dictionaries | Services |

Search Termse

-
=
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1.
2.

28

Click the plus sign (+) to drill down through a source to find the information you require.

Click the title of a document to access the text.

3. To view the table of contents for the index or bulletin for your source, click on the View drop-down list.

@ LexisNexis:

Home > Services

FEETR OB Alerts ' Sources

Search | Browse § Wllgil5
NOTE: When selecting iterns to search, select the checkbox, then click the search tab above

Wiew |Table of Contents

[ all

High Ct & Federal Ct

T EGeneral Information

T BRecent Developments

[ 2 [Z) Trade Practices
[B) Review of the Trade Practices Act 1974 e

[ & [3 Bankruptey
™ B Industrial Relstions Court of Australia

Home | Cases | Legislation | Commentary | Forms & Precedents |Joumals | Dictionaries | Sewvices |

Histary | Prefarances | Sign Out | Contact Us | [ElHelp

Quick Search

—

& = [T Tagaed Items Only
Z (@ saarch

How do I...2

> Find a section of
legislation®

= Search a particular
guidecard/chapter?

= Search for ASIC
releases?

= Search for codes of
practice and sther guasi-
leaislative instruments?
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You can selectl]
or view only those tagged sections at a later stage.

Note: You [
source, you'll see a message warning that if you continue, the tagged items in the first source will be lost.

To tag a document or branch, check the box next to the document or branch title.

1.
2,

To pril

document numbers you tagged displayed in the Selected Items box under Document Range.
To view tagged documents or sections in the Document View, click the Document View icon

[l all

Search

Home > Cammentary

[ alerts | Sources

Home | Cases | Legislation | Commentary | Forms & Precedents | Journals | Dictionaries | Services |

Search | Browse & Wl =TG4

NOTE: Whan selecting items ta search, select the cheokhox, than click the search tab abave [ )

¥iew |Table of Contents =

[] ¥ Halshury's Laws of Australia

T @5 — aboriginals and Torres Strait Islanders

[T B10 — Administrative Law

¥ E15 — agency

B 515 Suency.
[T & [2 About this Title

Qe a 1) NATURE AMD FORMATION
e B 2] AUTHORITY OF THE AGENT

M B [3{3) DELEGATION
[ [ (4] RATIFICATION

Quick Search

8 &= ¥ Tagged Itsms Only

00 - o'

How do I...2

= Find references to cases?

= Find references to
legislation?

> Limit my searchto a
particulsr
quidecard/chaptar?

View a Tutorial

= Dverview

= Searching

= Working with Results
= Delivering Results
= Scheduling Searches
= Selecting Sources
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You can use the browse function to limit your search to particular guide cards, chapters, or parts of a source.

Quick Search

1. Tag the documents you wish to search across in the table of contents. To tag a document or branch, check the box next to the
document or branch title.

2. Enter your search terms in the Quick Search box in the top right hand corner of the screen.
3. Ensure that the Tagged Items Only box is checked before running the search.

Full Search

Tag the documents you wish to search across in the table of contents as per above.
4. Click the Search tab at the top of the form to use the full range of options in searching those items that you have tagged.
5. The search form will now contain an additional box showing the sections of the source you wish to search across.
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Home > Cammentary

Search Alerts Sources

Home | Cases | Legislation | Commentary | Forms & Precedents | Journals | Dictionaries | Services |

Search | Browse @ WL TNGT8)

NOTE: When selecting items to search, select the checkbox, then click the search tab above

view [Table of Cantents [ E& &=

(i al %

[il ¥ Halsbury's Laws of Australia
[T ©5 — aboriginals and Torres Strait Islanders
-

¥ E15 — agency

10 — Administrative Law

[¥ =15 Agency
[ & [B bout this Title
[T B [ (1) HATURE AND FORMATION
[T [3) {2) AUTHORITY OF THE AGENT
¥ @ [ (3) DELEGATION
M E B (4) RATIFICATION
O @ (53 DUTIES OF AGENT T PRINCIPAL

¥ E1{6) RIGHTS OF AGENT AGAINST PRINCIPAL
M E [ {4) Remuneration %
¥ E [3 (B} Indemnity
B [F{C] Lien

How do T

> Find references ra cases?

> Find references o

= Limit my searchto 3
particulsr

guidecard/chapter?

View a Tutorial

> Ouerview

> Searching

> Working with Results
= Delivering Results
= Echeduling Searches
= gelecting Sources

Home > Commentary

Search Sources

Home | Cases | Legislation | Commentary | Forms & Precedents | Joumals | Dictionaries | Services

ommentary

Search Terms ;I
= Save This Search

Usz connactors to shaw relation of terms (apple and orange, trade w/S act, jurt finds jury, jurar, etc)

Connectors Help

selected Items
(3) DELEGATION -

(6) RIGHTS OF AGENT AGAINST
PRINCIPAL

{A) Remuneration
{B) Indemnity ;I

Edit Ttems

clear Ttems

¥ search an selected items anly

Sources | Halsbury's Laws of Australia =] Lil

More Sources | Edit Sources

Commentary Search

< Commentary

= Bulletins

= Commentary
Indeues/Tables

Related Searches

> Legislation Search

= Forms And Precedents
Search

> Gervices Search

History

= Recent Searches
= Recent Documents
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Delivery

From your search results or from the Table of Contents, select documents to print, email or download by checking the boxes that appear to
the left of the document title. You can select up to 200 documents in a single delivery session.

In the upper left corner of vour results page or browse page, click the icon for the selected delivery method you want to use: Print,

Download or Email &5 =1 [F

Provide the information on the form that appears. (Click the question mark icon [zl on the form for more information about completing it).

1. Select the Document View format - choose to print the full
text of selected documents or choose to print the list of your
results.

2. Select the Document Range - print the current document
only, print all documents, or print selected or tagged
documents.

3. Select Page Options, such as beginning each document
on a new printed page.

4. Select the Font Options.
5. Click Print to deliver your results.

6. Click Print Preview [Pim?rsi=v] tg display the text from the
documents you intend to print.
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Print Documents

Source: Practice & Procedure High Ct & Federal Ct

Printer: HTML Format for Attached

Printer !_P_riﬁmeﬂ |Cance| ;ﬂ

Document Yiew:

Document Range
d 2l Documents (1 - 2)
@ Tagged Documents (2)
 Selected Items

|1J2 | &0, 1,3-5,9

Page Options:
[T Cover Page
[T End Page

¥ Each doc on new page

G Font Options:

[T Search Terms in Bald Type
[T Search Terms Underlined
V¥ ‘ariable Width Font

Printing is subject to Terms and Conditions,

Please review them, e | Print Preu}eﬂ |Cance| ->?|




5.

6.

Choose the download Format - download in Microsoft
Word, HTML, or Generic (RTF).

Select the Document View format - choose to print the

full text of selected documents or choose to print the list
of your results.

Select the Document Range - print the current

document only, print all documents, or print selected or
tagged documents.

Select Page Options, such as beginning each
document on a new printed page.

Select the Font Options.
Click Download to deliver your results.

Note: If a document is available in PDF format (eg cases
in Australian Law Reports, legislation in LawNow), the PDF
link is available next to the document title.

Download Documents

Source: Practice & Procedure High Ct & Federal Ct

L Bk
HTML Document Range
Generic{RTF

Document FIEw [T &l Documents (1 - 2)

1 Format: |word(DOC) =

Documen

& Tagged Documents (2)
 Selected Items

|11.2 e.gi 1,3-5,9

e Font Options:

[T Search Terms in Bold Type
[T Search Terms Underlined
¥ “ariable Width Font

(6) feonei

4 Page Options:
[C Cover Page
[T End Page

¥ Each doc on new page

Downloading is subject to Terms and Conditions. Please review them,

Related Content [Select Related Content <]
(& Ezofa(x
O @ Hiesi»

& 1 B 3 e

1oof &3] b
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1. Choose whether to deliver the documents as inline text Email Documents

or as an attachment. Source: Practice & Procedure High Ct 2 Federal Ct

e Format: [word(DoC) 7] [Cancel x|
0 Add a brief note:

2. Choose the Format of the email attachment containing
your documents - Microsoft Word, HTML or Generic
(RTF).

3. Enter the desired email address.

4. Choose to Add a brief note to accompany the email. S GEPANESEDMER Y GaA j

This step is not compulsory in completing the email @ Last 10 email addresses:

request Ielizabeth.hodgson@lexisnexis.com.au;’l
5. Select the Document View - choose to email the full Dincumentyie e G Document Range

text of selected documents or choose to email the list 6|D°°Ume“t view (5] © all Documents (1 - 2)

of your results. & Tagged Documents (2)

. € Selected It
6. Select the Document Range - email all documents or Ius
Lz 1,35,

tagged documents only. BRI
7. Select your Page Options. e"age Dotidns @ Fit oG

s F . [T Cover Page [T Search Terms in Bald Type
8. elect your Font Options. [T End Page [T Search Terms Underlined
9. Click Send to deliver your results. I Each doc on new page ¥ Wariable Width Font

Ernail distribution iz subject to Terms and Conditions, Please review them, e |‘Cance| m
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Two sources of help are available to assist you in using this product.

You can access general help for each page by
clicking Help on the LexisNexis AU system’s
top navigation bar. Once inside Help:

1. Navigate using the table of contents and
index, located on the left-hand side, to find
other areas of interest.

2. Click the Back link in the bottom frame to
return to a previous section.

3. Click the Print Help link to print the Help
contents you are currently viewing.

Contents | Index

Q.

Alerts

legal update, create ) e :
leqal update, delete Use this form to search within your subscribed cases sources,

leqal update, edit Depending upon your subscription, this may include reports
scheduled searches, create series such as dustralan Law Reports, Family Law Reports
scheduled searches, delete gte, Unreported Judgreents, the cases partion of Casefase

scheduled searches, edit Case Citator, Austratian Current Law - Seporter and the
scheduled searches, run Australian and MZ Citator to UK Beports,
B all fields except Search Terms are optional.

Boolean searching Search Examples:

Browsing a source
getting started
quick search
taqging documents

3 LexisMexis®: Research Help - Microsoft Internel Explorer =101 Dﬂ
@ LexisNexis: Cases Search Form  Related Topics: j
Help Searching Casefase Care Citator

Searching Australizn Current
Lo - opter

Searching ANZ Citatar
Searching from Each Tab
Developing a Search

Find a case when you know one or both of the parties
Find a case when yvou have part of the citation
Search for cases on a particular topic or issue

Browsing the source direie
PP W R T N
4] | r

Find cases considering legislation LI

Find a raca on a2 narticnlar icena whan all o lenmaa ic

E

ac

k

Caontact Us | Print Help
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Detailed help is available for every
form (such as Cases Search,
Preferences, and so forth).

Search alerts ' Sources \\

Home | Cases

Browse@ Cases
1. Access form help by clicking

the question mark icon [Z! in
the upper right corner of any

Search Terms ;l

*Legislation | Commentary | Forms & Precedents | Journals | Dictionaries | Services |

form h relation of terms (apple and orange, trade w/S act, jur! finds jury, juror, etc)

2. Click on any of the links in the How da I...2

> Find a caze when I know

Help panel to the right side of ne or bath of the parties?

= Find cases on a particular

the search form. fopic or issus?

= Find a case when I have
part of the citation?

> Find a case when I know
the judge's name?

= Find cases considering
leqislation?

% Can'tfind an Unreported
Judgment?

View a Tutorial
= QOuetview
= Searching

Click the Contact Us link to request TR

i i i Scheduling 5 h
more mformatlo_n orto _prowqe us e
feedback on using LexisNexis AU.

6 LexlsNexlS' History | Preferences | Sign Out | ContsctUs | [Z]Helo
Horne
Search Alerts Sources %
Home | Cases | Legislation |Commentary | Forms & Precedents | Joumnals | Dictionaries | Services |
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CONTACT US

Electronic Helpline: 1800 999 906

Email: helpline@lexisnexis.com.au

Lines open Monday to Friday, 8am-8pm EST
Customer Relations: 1800 100 161

Lines open Monday to Friday, 8am-6pm EST
Web: www.lexisnexis.com.au

Our ref: AT Nov 04
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